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Welcome

The TFG4000 Professional Edition Software Series is a set of business management software
applications that offer the robust functionality of an advanced management tool, yet tailored
to meet the needs and budget of your growing business. Each TFG4000 Professional Edition
application is integrated with other TFG4000 Professional Edition applications to provide you
the optimum benefits of business management software.

TFG4000 Professional Edition is an easy-to-learn, user-friendly system that requires only
minimal keystrokes for entering information. There are customizable dropdowns, font sizes,
and screen colors available, as well as powerful search capabilities and built-in help features
to help guide you through the system. With TFG4000 Professional Edition, you have the
ability to pull up various summary screens, enter as little or as much data as you need,
process a variety of reports - all of which help you save both time and money, which will
add directly to your bottom line. For added convenience, TFG4000 Professional Edition also
allows you to run the system in either single or multi-user mode, whichever works best for
your business. Other features include optional security, as well as data import and export
features, which save you the work of re-keying information. In all, TFG4000 Professional
Edition is the smart source for business management. A simple solution for a complex
process.

System Requirements

Microsoft Windows XP®, Microsoft Windows 2003 Server®, or Microsoft Windows 2000
Server®, with the latest Service Pack applied.

Pentium® class processor, 1 ghz or greater.
100MB free disk space.
256MB of RAM (512MB or more recommended).

Network Interface Card configured to use TCP/IP if installing in multiple user mode (client /
server)



Starting TFG4000 Professional Edition

Perform the following steps to start TFG4000 Professional Edition in either Single or Multiple
User Mode:

Single User

1.

2.

3.

Open the “Start” menu, and then select the “Program” or “All Programs” option.
Select “TFG4000 Professional V1.4" from the program list.
Select “TFG4000 Professional Single V.1.4" to start.

The TFG4000 Professional Edition “Welcome” screen is displayed with the “Tip of
the Day”. You can select “Close” to continue the start up process or select “Next
Tip” to view more tips. You can also choose not to have the “Tip of the Day”
appear by selecting the check box next to “Don’t show Tip of the Day at Startup”
located on the Welcome screen. Select the check box again at any time to
reinstate the “Tip of the Day” feature.

If you see a “User” and “Password” field on your screen, enter the User ID and
Password that your System Administrator provided you, and either press “Enter”
or click “Sign On”.

If your screen only displays “Welcome” without any other fields, then click the
plus sign (“+”) next to the application you want to perform in the “NavTree”.

Click on the screen you would like to use.



Multiple Users (Not available in the Demo Version)

Server Startup

At installation, the server component is put in the Startup folder of the Program List.
It will automatically start at system start up. Perform this procedure only if

necessary.
1. Open the “Start” menu, and then select the “Program” or “All Programs” option.
2. Select “TFG4000 Professional V1.4” from the program list.

3. Select “TFG4000 Professional Server V1.4" to start.

4. The “TFG Web Server” screen is displayed. It will display the INI file and the

TCP/IP port number being used for the server. This window will display other
server messages as needed.

Client Startup

1.

2.

Open the “Start” menu, and then select the “Program” or “All Programs” option.
Select “TFG4000 Professional V1.4" from the program list.
Select “TFG4000 Professional Client V1.4" to start.

The TFG4000 Professional Edition “Welcome” screen is displayed with the “Tip of
the Day”. You can select “Close” to continue the start up process or select “Next
Tip” to view more tips. You can also choose not to have the “Tip of the Day”
appear by selecting the check box next to “Don’t show Tip of the Day at Startup”
located on the Welcome screen. Select the check box again at any time to
reinstate the “Tip of the Day” feature.

If you see a “User” and “Password” field on your screen, enter the User ID and
Password that your System Administrator provided you, and either press “Enter”
or click “Sign On”.

If your screen only displays “Welcome” without any other fields, click the plus ign
(“+) next to the application you want to perform in the “NavTree”.

Click on the screen you would like to use.



Built-in Help
Help is available at the screen, field, and column level, as well as built-in tool tips.

Screen Level Help

To select screen level help, click “Help” on the “Menu” bar, and then select “Screen Help”.
Help for the screen is then displayed.

Screen Help
" About

Field Level Help

To select field level help, right click on the field, and then click “Help” from the pop-up.
Help for the selected field is then displayed. You may also press the F1 key to get field
help.

Cut

Copy
Paste

Column Level Help

To select column level help, right click on the column heading, and then click “Help” from
the pop-up. Help for the selected column is then displayed.

Column Help




Tip of the Day

Each time you start TFG4000 Professional Edition, there is a “Tip of the Day” pop-up
displayed that describes some of the functionality that is available within the application. To
close the “Tip of the Day” pop-up, click the “Close” button. To view another tip, click the
“Next Tip” button. This feature can be turned off by clicking the box next to “Don’t Show Tip
of the Day at Startup” on the Welcome screen. A check mark will appear in the box
indicating the “Tip of the Day” should not be displayed during start up. To reinstate the “Tip
of the Day” feature, click the box and the check mark will disappear indicating the “Tip of
the Day” should be displayed during start up.

Example Only:

¥ TFG4000 Tip of the Day

TIP OF THE DAY

Did wou know you can change the size and position of the navigation tree?

There is a bar between the navigation tree and the rest of the screen. Position your
cursor over the bar until you see an arrow with two pomnts. Left click and while still
holding the mouse button dowern, move left or right to make the nawigation tree
farrower of wider,

To move the tree, click the "View" menu and select "Flip Tree Position". The tree will
be position on the right side of the screen. Repeat to move the tree back to the left side

of the screen.

To hide the tree completely, click the "Wiew" menu and select "Hide Navigation Tree".

e

Mext Tip

Tool Tips

Throughout TFG4000 Professional Edition, there are embedded tool tips that help describe
certain areas on the screen. You simply roll your mouse (cursor) over the area in question,
and a pop-up will describe that specific area. The tool tip pop-up will remain visible for a few
seconds, then it will disappear automatically.

Example Only:

Item Definiion Item Information | Item Sum mary] Price Sum mary]

Current ltem
.R?:; Delete
ltem/Part: v #h i - [=
Description: = £ ud =
P | [Identification of the ItermnPart ,2 - =
x
Wl QLI




Using TFG4000 Professional Edition

You can navigate through the TFG4000 Professional Edition screens by using the “NavTree”,
the “Goto Screen” section of the “View Menu”, and the tabs on the top and bottom of the
screen. For easy use, the toolbar provides a variety of functions for you to choose from as
you use the TFG4000 Professional Edition applications. There are buttons located on the
toolbar that allow you to perform various functions from each screen, such as
opening/displaying data, saving data, etc. The “Menu” provides useful functions as well,
such as printing reports, documentation, help, etc.

Sample Screen

T 1FGA0/ iemDetail

Actio
| imm| o
q
1‘FG e Item Definiton | tem Enformation] fterm Zommary| Frice Summary|
ot My Tree Curtmen R
i $[:Menw ItemiPart: ¥{Bo0RCASE, 48° pe: [azsembly Bl
» Bill of Materiats Deserig 48" Hooden [fach )
» Inveniory Control Product Group: |active B
# J Process/Job Order
&= B® Systern Acministration
¥ Ukser Control S
b Location Control
¥ Drepdown Conlrol Number: [ac-127 Sales: Sales Item ¥
¥ System Verisbles Commodity: [Rockcase ttem Level:  [Aon
¥ Database Definitiors
* Serial Mumbsrs
» Utility Contral N
* Welcome _
Gross: DiscountPercent: "
Discount: | ttem Cost: 20.000
—
Net:

Message:  |Next Record Loaded

s ltem Defiritin Bl ONgatieials Invertory |
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Menus

Each screen in TFG4000 Professional Edition has various menus available for working with
your data. The following describes the purpose of each menu and special features.

Action

This menu is for printing screens and for exiting TFG4000 Professional Edition. It contains
the following menu items:

Print Prints the entire screen in either portrait or landscape
mode.
Print Text Prints only the text currently displayed on the screen in

either portrait or landscape mode.
Exit Terminates the TFG4000 Professional Edition session.
Edit

This menu is for performing cut, copy, and paste operations on data. It contains the
following menu items:

Cut When you highlight data and use this function, the data
is removed from the screen and is available in a
clipboard for pasting. Holding the “Ctrl” key and
pressing the “X” key will perform the same operation.

Copy When you highlight data and use this function, the data
is copied into a clipboard and is available for pasting.
Holding the “Ctrl” key and pressing the “C” key will
perform the same operation.

Paste When you position your cursor in a field and use this
function, data you have previously put into the clipboard
using the “Cut” or “Copy” operation will be pasted after
your cursor. Holding the “Ctrl” key and pressing the “V”
key will perform the same operation.

Note: If your keyboard is in “insert mode” the data will not overlay data that

follows, but if it is not in “insert mode” it will. Press the Insert key on your
keyboard to change your insert mode to whichever way you prefer.

11



View

This menu allows you to change the way the TFG4000 Professional Edition screens are
presented and how you navigate the screens. It contains the following menu items:

Set Font Size

Hide Calendar Buttons

Flip Tree Position

Hide Navigation Tree

Allow Word Wrap

GoTo Screen

You can choose a font size from 10 to 18. With larger
font sizes you may have to scroll to see the entire
screen.

Toggles whether or not a Calendar button is displayed
next to the date fields.

Changes the position of the “NavTree” to either the left
or the right side of the screen.

Hides the “NavTree” from the screen. Click it a second
time to display the “NavTree” on the screen.

Note: The dark arrows in the bar between the NavTree”
and the main screen perform the same function.

Determines how text may be viewed. When it is
checked, text may be displayed on multiple lines and
can be viewed by scrolling up and down. When it is not
checked, text may be viewed by scrolling right and left.
Word wrap is allowed only if the system variable
Allow_Wrap is set to Yes.

Displays the “NavTree” in menu format. You can use
this method to navigate the screens at any time but it is
particularly useful if you hide the “NavTree”.

View Documenta

Set Font Size 4
Hide Calendar Buttons
Flip Tree Position

Hide Navigation Tree

Process/Job Order »  Bill of Materials
System Administration »  Inventory Control

12



Reports

This menu shows you the reports or forms available for the screen you are on. There will be
various menu items depending on the screen. There is also an “All Reports” menu available
from any screen.

Note: Forms are structured documents such as Invoices, Packing Slips, Purchase Orders,
etc. Though you will see forms in the Reports menu on some screens, you will not
see forms in the All Reports menus.

Specific Reports Displays reports associated with the screen you are on.

All Reports Displays a menu of reports available for all the
applications you have installed. This menu does not
include Forms.

Reports Documentation Help

Inventory Management »

S Process/Job Order '
Sales Orders ’
Material Scheduling '

DI Gl GE G = =0 e8] Purchasing Item Summary Report

Warehiousiry *  Purchase Order Hislory Reporl
Preventive Maintenance »  Pirchase Order Summary Repaort
Common Applications »  Suppller Statlstics Report

System Administration »  Supplier Summary Report

Documentation

This menu lets you select the TFG4000 Professional Edition manuals for viewing and
printing.

Help

This menu provides help about the screen you are on and information about TFG4000
Professional Edition. It contains the following menu items:

Screen Help Displays information about the screen you are on.
About Displays information about TFG4000 Professional
Edition.

13



Buttons & Icons

Each screen in TFG4000 Professional Edition has various buttons available for working with
your data. The following describes the purpose of each button and special features. It also
explains other icons you may see on the screens.

|4 [FHE x « » &

Toolbar Buttons < | & B | » o

Use the following buttons to perform TFG4000 Professional Edition application tasks. The
buttons displayed change with the screen you are working with.

Previous screens ©

Use this button to return to your previous screen. You can go back up to ten screens.
Cutting, copying and pasting text| # & &

You can use “Cut” and “Paste” to move selected text. You can use “Copy” and “Paste” to

copy selected text and paste the copy in another place. “Cut”, “Copy”, and “Paste” can also
be selected from the “Edit” menu.

Working with data R H X 4« » &
You can perform many different operations by using these buttons:

& Erase This button clears data from the screen. It does not
update any data; it merely clears the data away to make
it easier for you to enter something else. It is
particularly useful for resetting summary screens for a
new search and it may be required when adding new
entries on some screens.

& Open (Display) This button retrieves data that has been previously
saved for viewing and/or modifying. The Enter key
executes this button by default.

H save This button stores new data and modified data. If you
enter new data or change existing data and do not click
this button, the system prompts you to do so.

D) Cancel This button reduces any remaining quantities to zero
and changes statuses to “Cancelled”.

X Delete This button deletes previously saved data. On screens
indicated as “definition” screens, the delete button
deletes related data in addition to the data currently
displayed. On all other screens only the data displayed is
deleted.

4 Previous This button retrieves data that alphabetically precedes
the currently displayed data.

14



P Next

EZ2 copy

= Print

" Build

&3 Refresh

Split

Screen Buttons

This button retrieves data that alphabetically follows the
currently displayed data.

This button copies data from one place to another. It
can copy related data in addition to the data currently
displayed.

This button sends your document to the printer to be
printed.

This button extracts eligible data from one place to
create a new definition in another place. For example, it
can extract customer order data to build a new invoice.

This button rebuilds the data on the screen.

This button will take lines from one document to create
a new document using the lines selected.

Throughout the screens are buttons that perform functions.

#% search

B Calendar

¥ Dropdown

Table Buttons
Throughout the tables are buttons

Bl GoTo/Selection

This button is for finding data you have already entered.
When you click this button a search box pops up.

This button provides a pop-up calendar for selecting
dates. You can choose the month and the year, and
then double-click on the date you desire. Click “Today”
to re-position the calendar on the current date. Click
“Cancel” if you decide not to select a date. Dates can be
entered without using the “Calendar” button if desired.
Manually entered dates are verified so a pop-up appears
prompting you to correct a date if it is invalid.

This button provides a “dropdown” list of pre-defined
values from various fields that have this button next to
it. If you click on one of the values from the dropdown
list, that value will appear in the adjacent field.

that perform functions.

This button is for either transferring to another screen or
selecting data. When you right-click on this button, it
displays a menu of related screens and/or a menu of
selection activities. To transfer to another screen, click
on the screen you desire and that screen is displayed
with the appropriate keys already filled in. To select
data, such as a component or inventory location, click
the action you want.

Goto Item Definition

Goto Bill of Materials Definition

15



 Properties

= Add Rows

¢ Scroll to the Left
» Scroll to the Right
“« Scroll Up

¥ Scroll Down

¥ Scroll Bottom

X Scroll Top

M Scroll Left

M Scroll Right

Information lcons

This button is located at the lower left corner of each
table. It allows you to edit the layout of the table. You
can use this button to hide or display columns in the
table and to restore the original table layout.

This button appears in the lower right corner of
modifiable tables so that you can put more empty rows
on the screen for adding data to the table. If you are
trying to enter another row in a table and there are not
any blank rows to use, click the “Add Rows” button.
This button allows you to scroll to the left of the table.
This button allows you to scroll to the right of the table.
This button allows you to scroll up the table.

This button allows you to scroll down the table.

This button allows you to scroll to the very bottom of the
table.

This button allows you to scroll to the very top of the
table.

This button allows you to scroll to the very left of the
table.

This button allows you to scroll to the very right of the
table.

Icons on the screen show properties about the field.

* Numeric

T Key

v Required

This icon in the upper left corner of a field indicates that
the field is for a numeric value. You are able to enter
only numbers, commas, and decimals in fields
containing this icon.

This icon to the left of a field indicates that the field is a
key field and is required for this screen.

If you try to display or save data without entering a

required field, this checkmark icon is displayed next to
the missing field.

16



Field Colors

The fields on the screens and in screen tables have three different colors that have
functional significance.

Gray A gray field is display only, no entry allowed or necessary
White A white field is open for entering data
Yellow A yellow field indicates where the cursor is currently positioned

Changing Screen Table Properties

Tables that appear on screens can be modified. The columns can be re-sized, re-positioned,
hidden, and un-hidden.

To re-size a column move your cursor over the column heading you want to re-size and
move to the right until you see an arrow with two heads. Click, then still holding the mouse
button down, move the cursor to the right until the column is as wide as you want or to the
left until the column is as small as you want.

To re-position a column click on the column heading, then still holding the mouse down,
move the column to the where you want it and release the mouse. Some columns are key
columns and will not remain where you re-position them.

Note: Re-sizing and re-positioning remain in effect for the duration of the current session.
The default sizing and positioning is restored when TFG4000 Professional Edition is
restarted.

To hide or unhide a column click the Properties button = located in the lower left corner of
the table. A red check mark next to the column name indicates the column will be
displayed. If there is not red check mark next to the column name it will not be displayed in
the table. There may be multiple tabs for the table, so you must click on the tab that
contains the column(s) you want. To save the changes you have made, click the “OK”
button. To discard the changes you have made, click the “Cancel” button. To reset the
properties back to the default properties, click the “Restore Default Visibility” button.
Another pop-up will appear asking the range you wish to restore. Use the dropdown
provided to select either “All Tabs”, which will restore the defaults for the entire table, or
“Currently Displayed Tab Only”, which will restore the default properties only for the portion
of the table indicated by the tab you are viewing. Once you have made your selection click
“OK” or “Cancel”. That pop-up will disappear and the column visibility properties are reset
as requested or the reset action is cancelled. Then you may click either “OK” or “Cancel” to
save or discard the property changes.

Note: Property changes remain in effect even after TFG4000 Professional Edition is
restarted.

17



Performing Searches

There are two types of searches in TFG4000 Professional Edition that are similar in
appearance, however they have different functionality. The first is a “Search” associated
with a field on the screen. The second is a “Search Pop-up” which is found on tables. One
of the differences between the two is that a “Search Pop-up” can load multiple table rows to
the screen at one time but a “Search” will not. Another difference is that “Search” screen
results can be printed but “Search Pop-up” results cannot.

Search Screen (Fields)

Below is an example of a search screen that may be used to locate information already
entered into the system, and/or to automatically populate the fields on the screen that you
are currently viewing or editing. When search results are displayed you can move the
columns into different places on the search screen so that the values can be viewed in
positions different from the default layout. Click the heading of the column you wish to
move then drag and drop it into the desired position. Resize columns by moving the cursor
over the heading until you see an arrow with two heads. Click, and with the mouse button
still down, move the cursor right or left until the column is the desired width. The default
layout is restored when the “Search” button is pressed and when you exit the search. In
addition, you also have the option to retain search parameters by checking the box located
next to “Retain Search Parameters”. This option allows you to save the search parameters
you used for future searches.

Example Only:

= Search El
Search for item Numbers
Daouble-Click Search Results to Load Data to Screen
Search Criteria
Max Rows To Display: 30 I~ Retain These Search Parameters
Find Item MNumbers [starting with |[sockcase

S concel | et |

ftemiPart Description Type Unit of Measure
BOOKCASE, 48" 45" Wooden Bookcase Assembly Each
BOOKCASE, 60" B0 Wooden Bookcase Assembly Each
BOOKCASE, 84" &4" Wooden Bookcase Assembly Each

3 records found

18



Using the Search Screen

1.

2.

5.

6.

Click the Search button #4 located directly next to the field you want to search.

Enter the maximum number of rows of data you want to display in your results.
The default is “30”.

Select one of the search choices using the dropdown. The default is “starting
with”.

Enter all or part of the value you want to search with. You may leave the search
field blank to return all applicable records in the database. If there is a value in
the screen field you are searching on, it will be copied to the search field. You
can change the search field value on the “Search” screen.

Click the Search button #4.

Double click on the row you desire to load the information to the main screen.

Modifying the View of the Search Results

To modify the view of the search results, do the following:

1.

To re-size a column move your cursor over the column heading you want to re-
size and move to the right until you see an arrow with two heads. Click, then still
holding the mouse button down, move the cursor to the right until the column is
as wide as you want or to the left until the column is as small as you want.

To re-position a column click on the column heading, then still holding the mouse
button down, move the column to where you want it and release the mouse.
Some columns are key columns and will not remain where you re-position them.

To re-size the window move your cursor over the edges of the window until you
see an arrow with two heads. Click, and then still holding the mouse button
down, move the cursor to increase or decrease the size of the window.

Printing the Search Results

To print the search results, use these steps:

1.

2.

Click the Print button = on the “Search” screen.

Type or select the appropriate formatting options in the dialog box and then click
“OK” to print the report.

19



Search Pop-Up Screen (Tables)

Below is an example of a search pop-up screen that may be used to populate columns in the
table on the screen that you are currently viewing or editing. When search results are
displayed you can move the columns into different places on the search pop-up screen so
that the values can be viewed in positions different from the default layout. Click the
heading of the column you wish to move then drag and drop it into the desired position.
Resize columns by moving the cursor over the heading until you see an arrow with two
heads. Click, and with the mouse button still down, move the cursor right or left until the
column is the desired width. The default layout is restored when the “Do Search” button is
pressed and when you exit the search pop-up.

Example Only:

Search Criteria

Max Rows To Display: 30
Find values [starting with | |Bookease

Cancel

ftemPart Description Unit of Measure Type
BOCHCASE, 458" 45" Wooden Bookcase Each Aszembly
BOCHCASE, 60" G0" Wooden Bookcase Each Aszzembly
BOCOKCASE, 84" 24" Wooden Bookcaze Each Aszzembly

Select Al ‘ cancel ‘

3 records found
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Using the Search Pop-Up Screen

1.

2.

Click the GoTo/Selection button &l in the row you want to search.

Enter the maximum number of rows of data you want to display in your results.
The default is “30”.

Select one of the search choices using the dropdown. The default is “starting
with”.

Enter all or part of the value you want to search with. You may leave the search
field blank to return all applicable records in the database.

Click the “Do Search” button.

To select just one entry, double-click on it to populate the fields on your screen.
To select more than one entry, hold down the “Control” key while you click on the
other selections with your mouse, then click “Load to Screen” to populate the

information.

To load all of the entries to the screen table, click the “Select All” button and then
click the “Load to Screen” button.

Modifying the View of the Search Results

To modify the view of the search results, do the following:

1.

To re-size a column move your cursor over the column heading you want to re-
size and move to the right until you see an arrow with two heads. Click, then still
holding the mouse button down, move the cursor to the right until the column is
as wide as you want or to the left until the column is as small as you want.

To re-position a column click on the column heading, then still holding the mouse
button down, move the column to where you want it and release the mouse.
Some columns are key columns and will not remain where you re-position them.

To re-size the window move your cursor over the edges of the window until you
see an arrow with two heads. Click, and then still holding the mouse button
down, move the cursor to increase or decrease the size of the window.

Printing the Search Results

To print the search results, use these steps:

1.

2.

Click the Print button =1 on the “Search” screen.

Type or select the appropriate formatting options in the dialog box and then click
“OK” to print the report.
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Working with Reports

You can view, modify, and print reports by using the “Reports” menu located just above the
toolbar.

To view a report, follow these steps:

1. Click on “Reports” above the toolbar. A menu will drop down indicating which
reports can be generated from that screen and a selection for All Reports. Click
on the report name that you want.

2. A status window will appear showing that the system is generating the report.

3. You will then see your report displayed on the screen.

To modify and/or print a report, follow these steps:

1. Click on “Reports” above the toolbar. A menu will drop down indicating which
reports can be generated from that screen. Click on the report name that you
want.

2. A status window will appear showing that the system is generating the report.

3. You will then see your report displayed on the screen with this toolbar at the

top:

Frinting Options Fage Setup IWemarize ‘ Frint ‘ Freview ‘ Excel ‘ Revert ‘ Help ‘ Close

Printing Options Allows you to set the Page Number Prefix, number of
pages wide, and the Repeat Section Header/Footer
settings. Adjust the settings to your specifications and
then click “OK”.

Page Setup Allows you to adjust page settings such as page
orientation and margins. Once finished adjusting the
settings, click “OK”.

Memorize Allows you to save report settings under a report that
you name yourself so you can run the report again with
the same settings. You can save settings for a report
under different names so you can have multiple versions
of the same report formatted different ways. The new
report names appear in the Report menu at the top of
the main screen (after you go to another screen and
come back) and they are available only to you, other
users will not be able to see reports you memorized.

Print Allows you to select printer settings and print your
report. Once finished with settings, click “OK” to print
the report.

Preview Allows you to preview your report layout before you
actually print. Once finished previewing, click “Close”.
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Excel Allows you to save your report as an Excel document.
Once finished naming and specifying where to save your
report, click “Save”.

Revert Allows you to discard all layout changes and revert to
default settings. Simply click either “Yes”, or “No”.

Help Shows the Report Layout Instruction screen.

Close Click this button to close the report and return to the
main screen.

In some reports the selection criteria can be changed in the report window. Adjust the
selection criteria as desired, and then click the “Refresh” button to reload the data. When
you exit the report you will be asked if you want to update the screen with the refreshed
data from the report. Click “Yes” to update the screen or “No” to leave the screen as it was
when you started the report.

Report layouts can be modified. Columns can be re-sized, hidden, and un-hidden and
sections can be hidden and un-hidden.

To re-size a column do the following:
1. Move your cursor over the column heading you want to re-size.
2. Move to the right until you see an arrow with two heads.
3. Click, then still holding the mouse button down, move the cursor to the right until
the column is as wide as you want or to the left until the column is as small as
you want.

To hide or unhide a column, do the following:

1. Right click in the report area or the long, thin “Edit” button on the left side of the
report window to get the “Report Layout Options” window.

2. Click the “Column Visibility” tab. A red check mark next to the column name
indicates the column will be displayed. If there is not red check mark next to the
column name it will not be displayed in the report.

To hide or unhide a report section, do the following:

1. Click the tab for the section you want to hide or unhide.

2. Right click in the report area or the long, thin “Edit” button on the left side of the
report window to get the “Report Layout Options” window.

3. Click “Do Not Print This Section”.

To save the changes you have made, click the “OK” button. To discard the changes you
have made, click the “Cancel” button.

To reset the properties back to the default properties, click the “Revert” button located on
the report toolbar. A dialog box will appear asking if you want to discard changes and revert
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back to default settings. Click either “Yes” to restore the defaults or “No” to keep the
changes.

Note: Report layout changes remain in effect even after TFG4000 Professional Edition is re-
started.

Logos on Forms and Reports

Special forms such as job order forms, customer order forms, packing slips, invoices, and
purchase order forms have an area for a company logo. The logo is controlled by system
variable Form_Logo.

Reports have an area for a company logo too. The logo is controlled by system variable
Report_Logo.

See the System Administration Users Guide for more information about these system
variables and how to set them.

Working with Summary Screens and Summary Reports

TFG4000 has many summary screens and reports available for locating data, listing data,
and summarizing data. Each summary screen and report has various fields for search
criteria that are used in combination with one another. The search criteria fields can use
wildcards and other sophisticated SQL search techniques. For more information about
wildcard characters that can be used for advanced searching, refer to the following Microsoft
website:

http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/off2000/html/acconWildcardCharactersS.asp

Due to differences between Access and ANSI wildcard characters, when reading this website
and using wildcards in TFG4000, substitute as follows:

% for *
_for?
# is not used

Also note that these wildcards cannot be used in searches.
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Initial Setup

Material Scheduling System Variables
The first thing you must do before using TFG4000 Material Scheduling is understand the
system variables used by the application.

TFG4000 is installed with certain features that can be changed. The features are controlled
with system variables. There are at least two system variables you need to understand
before you start using Material Scheduling.

Material_Scheduling (default is “Yes”) — With this variable set to “No”, Material
Scheduling will not run. With this variable set to “Yes”, Material Scheduling will process
regularly based on the interval defined with system variable TFGMaterialScheduleTrigger.

TFGMaterialScheduleTrigger (installation default is “5”) — This variable indicates the
interval in minutes between Material Scheduling processing. With this variable set to O,
material scheduling will not run. Set it to 1 or higher to begin material schedule processing.

For more information about viewing and setting system variables see the System Variables
screen in the System Administration User Guide included on the TFG4000 CD, which is
available from the Windows “Start” menu or from the “Documentation” menu within
TFG4000. The documentation is also available online.
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Item Schedule Data

What is material scheduling?

Many items are either manufactured or purchased. As demand for an item exceeds the
supply more must be built or purchased. The demand for an item is based on requirements
and supply is either available inventory or pending orders such as job orders or purchase
orders. TFG4000 Material Scheduling uses the information provided for an item to monitor
supply and demand to generate plans when inventory and pending orders are not enough
for the current demand.

Demand can be either independent or dependent requirements. An independent
requirement is for a parent item or the top level of an assembly. This would be the item you
sell. A dependent requirement is for a component needed by the parent item. This would be
something you need to build the item you sell.

Supply is available inventory or pending orders. If an item is manufactured, pending job
orders offer supply. If an item is purchased, purchase orders offer supply.

Scheduling Example

Company ABC builds bookcases. They use raw lumber to build frames and shelves for the
bookcases and they buy screws and brackets to assemble the bookcases. They have job
orders for bookcases as well as the frame and shelves. They have purchase orders for the
screws and brackets. Their bill of material looks like this:

Parent Item — Bookcase-A
Components — Frame-A(1), Shelf-B(2), Screw-X(8), Bracket-Z(8)

Note: The number inside the parentheses indicates the quantity of each component needed
to build one unit of Bookcase-A.

They have a sales order for 50 Bookcase-A, but they only have 40 in inventory. They need
to build 10 more. A job order for 10 Bookcase-A is created. The job order represents an
independent requirement of 10 for the parent item: Bookcase-A. It also represents
dependent requirements for the components: Frame-A(10), Shelf-B(20), Screw-X(80), and
Bracket-Z(80).

Note: The number inside the parentheses indicates the quantity of each component needed
to complete the job order.

Next we check supply. In inventory they have Frame-A(2), Shelf-B(0), Screw-X(20), and
Bracket-Z(25).

Note: The number inside the parentheses indicates the quantity of each component in
inventory.

They need 8 more Frame-A (10 needed minus 2 already in inventory), and 20 Shelf-B (20
needed and none in inventory). Since they build these there may be job orders already
pending so we check there first and find they have job orders to build 5 Frame-A, but none
for Shelf-B. So now they need only 3 more Frame-A because the other 5 already have a job
order to build them, but they still need 20 more Shelf-B.
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They need 60 more Screw-X (80 needed minus the 20 already in inventory) and 55 Bracket-
Z (80 needed minus the 25 already in inventory). Since these components are purchased
we check purchase orders and find there is a purchase order for 100 Screw-X and 10
Bracket-Z. Since the purchase order will bring in more than 60 Screw-X they do not need to
plan for more Screw-X, but even with the purchase order for 10 Bracket-Z they need 45
more Bracket-Z (55 more needed but only 10 more ordered).

Material scheduling will generate planned orders as follows:

Frame-A, quantity 3
10 originally needed

-2 in inventory
-5 on pending job orders
3 not satisfied by existing supply

Shelf-B, quantity 20

20 originally needed
-0 in inventory

-0 pending job orders

20 not satisfied by existing demand

Screw-X, no planned order

80 originally needed

-20 in inventory

-100 on pending purchase orders

-40 excess supply

Bracket-Z, quantity 45

80 originally needed

-25 in inventory

-10 on pending purchase orders

45 not satisfied by existing demand
Converting a Planned Order into a Job Order or Purchase Order

Planned orders can be converted into job orders or purchase orders. The order information
is referenced back to the original requirement.

For example, a planned order was generated to satisfy demand for item XYZ on customer
order ABC-CO line number 005.

The planned order is used to generate purchase order ABC-PO line number 001. In TFG4000
Purchase Order Management, on the purchase order screen there is a tab called “Order
Links”. On ABC-PO line 001, the order link shows customer order ABC-CO line 005 as the
reference to the original requirement.

If a job order ABC-JO was generated instead of a purchase order, in TFG4000 Job Order

Management, on the job order screen, job order ABC-JO would have customer order ABC-
CO and line number 005 as the reference to the original requirement.
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It is important to note that the quantity on the job order or purchase generated using the
planned order may not be the same quantity as the requirement reference. This happens
when part of the demand quantity is satisfied by existing supply.

For example, job order JO-123 needs 200 pieces of ITEMX to complete the order. If ITEMX
has 10 pieces in inventory, those pieces will be used to satisfy part of the demand for job

order JO-123. A pending purchase order PO-222 has another 40 pieces of ITEMX. Only 150
pieces to do not have any supply. So the planned order would be generated for 150 pieces:

200 required by JO-123
-10 already in inventory
-40 on pending purchase order PO-222

150 not satisfied by existing supply

A new purchase order generated using the planned order would have a line for ITEMX for a
quantity of 150 with a reference back to job order JO-123 where we would see the
component quantity is 200. We will know material scheduling found 50 pieces in existing

supply.
How Inventory is used in Material Scheduling

Inventory is the first type of supply to be considered during material scheduling. Each
warehouse, zone, and inventory location has a field called “MSP Usage” indicating whether
or not it may be used for material scheduling. If MSP Usage is “No”, inventory in that
warehouse, zone, or location is not considered for material scheduling supply.

Note: If MSP Usage is “No” for a warehouse, none of the inventory in any of the zones or
locations within that warehouse will be used for material scheduling even if MSP
Usage is “Yes” for the zones and locations. This is also the case if MSP Usage is “No”
for a zone. None of the inventory in any of the locations within that zone will be used
for material scheduling even if MSP Usage is “Yes” for the locations.

Only available inventory can be used, so if an item has any allocations against its on hand
inventory, the allocations are deducted first.

Next, safety stock must be deducted from available inventory. If there is not enough
inventory for safety stock, a planned order will be generated. The reference to the safety
stock is not displayed on the job order or purchase generated using the planned order, but
there is a reference there that is used internally.

Any available inventory after safety stock is satisfied is used to satisfy remaining demand
for the item.
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Item Schedule Data

Material Scheduling needs various pieces of information to know how an item should be
planned. Items can be planned using supply (inventory, purchase orders, job orders) versus
demand (customer orders and job orders) or it can be planned based on a pre-determined
inventory level called the “order point”. Planning parameters for an item include how
inventory for an item is acquired (manufactured or purchased), the quantity to set aside to
prevent outages (safety stock), and how long it takes to manufacture or purchase the item.

Item Data

This screen allows you to define if an item should be planned at all and if so, how it should
be planned and the planning parameters to be used during planning.
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Item Schedule Data Screens Explained

Item Data Screen

Use this screen to define how an item should be planned including planning parameters.

Item to Plan

Field

Item/Part

Type

Description

Unit of Measure

MS Plan

Item Scheduling Parameters

Field

Order Policy

Explanation

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Defines how the item is counted or measured. Some
examples of units of measure are "Ounce", "Pound", and
“Hour".

Indicates if this item should be planned by material
scheduling or not (Yes or No)

Explanation

Indicates how requirements are generated and how
planned orders are built for this item. Available policies
are:

None Generate requirements from
customer orders and job orders. No
planning is desired

Order Point Generate a requirement when

inventory falls below the Order
Point Quantity defined (see below).
Build the planned order using the
Fixed Order Quantity defined.
Requirement Generate requirements when
customer orders are entered and
when job orders are created. Build
planned orders based on the
requirement quantities.
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Sourcing

Fixed Order Quantity

Safety Stock

Order Point Quantity

Purchase Time

Order Point IM Address

Manufacturing Time

Order Point Email

Schedule Controls

Field

Minimum Order Quantity

Days Between Orders

Indicates if the item is purchased, manufactured, or if
supply can come from any source. Material scheduling
will use purchase orders to satisfy demand for items
with source “Purchase”, job orders for items with source
“Manufacture”, and purchase orders as well as job
orders for source “Any”.

Note: Purchase orders and job orders built specifically
for a customer order will be used to satisfy the
requirement for the customer order regardless of the
source type.

The quantity that should be ordered when item
inventory falls below the order point quantity.

The minimum quantity that should be maintained in
inventory to prevent critical outages. The safety stock
quantity is satisfied before considering any other
requirements.

The quantity used to determine whether or not an order
point requirement should be generated. If the Order
Policy is “Order Point” and the item inventory falls below
this quantity, an order point requirement will be
generated.

The lead time needed to acquire this item via purchasing
channels. This information is used to determine release
dates for purchase orders so item will be received in
time to meet required due dates.

The instant messenger address to which a message
should be sent when order point activity occurs. Multiple
addresses can be entered with a semi-colon between
addresses.

The number of days needed to build this item. This
information is used to determine release dates for
planned orders so manufacturing can begin in time to
meet required due dates.

The email address to which a message should be sent

when order point activity occurs. Multiple addresses can
be entered with a semi-colon between addresses.

Explanation

The smallest quantity of this item that should be
planned on a single order. Default is 1. Currently not
used.

The minimum number of days that should be planned
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Maximum Order Quantity

Days Supply

Multiple Order Quantity

Message Line

between orders. Currently not used.

The largest quantity of this item that should be planned
on a single order. Default is no limit. Currently not used.

The maximum number of days of supply to be ordered
at one time for this item. Currently not used.

Order quantities for this item should be in multiples of
this quantity. Currently not used.

Explanation

Displays information about the current status of the
screen including error messages.
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Accessing the Item Schedule Data Screen

1. Click the plus (“+) next to “Material Scheduling” or double-click Q “Material
Scheduling” in the “NavTree”.

_O r_

Click on the “View” menu. Select “Goto Screen”, then select “Material
Scheduling”.

2. Click “Item Schedule Data”. The “lItem Schedule Data” screen is displayed.

3. If there is an item or part number in the “ltem/Part” field, the scheduling data for
that item or part number is displayed on the main screen.
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Using the Item Schedule Data Screen

Use these procedures to erase the screen, display, update, add, delete, display previous,
and display the next item schedule data.

Erasing the Screen
To erase the data from the screen click the Erase button & located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying Scheduling Data for an Item
To display scheduling data for an item, perform the following steps:
1. Enter an item or part number in the “ltem/Part” field.
2. Click the Open (Display) button & located on the toolbar or hit the Enter key.
3. The scheduling is displayed on the main screen.
—or-

1. Use the Search button #4 next to the “Item/Part” field or the “Description” field to
select an item number.

2. Double-click on the “lItem/Part” you would like to display in the “Search” screen
table.

3. The scheduling data is displayed on the main screen.
Adding Scheduling Data for an Item
To add scheduling data for an item, perform the following steps:

1. Enter or select the item for which you wish to add scheduling data. See
“Displaying Scheduling Data for an Item” above.

2. Enter or select data as desired (see field descriptions to learn more about
scheduling data)

3. When done, click the Save button = located on the toolbar.
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Updating Scheduling Data for an Item
To update scheduling data for an item, perform the following steps:

1. Display the item you wish to change. See “Displaying Scheduling Data for an
Item” above.

2. Change data as desired.

3. When done, click the Save button i located on the toolbar.
Changes are processed as follows:

When MS Plan is changed from Yes to No, all planned orders are deleted and
requirements not linked to a purchase order or job order are deleted. Pegged
requirements remain and are processed until the demand is satisfied but no planning
is performed and no new planned orders are generated.

When MS Plan is changed from No to Yes, requirements are generated based on the
Order Policy defined as follows:

Order Point Inventory is evaluated to determine if it has fallen below the
order point quantity defined

Requirement Requirements are generated from outstanding customer orders
and job orders.

None Requirements are generated from outstanding customer orders
and job orders, but no planning is performed.

When Order Policy is changed from Order Point to either Requirement or None,
any outstanding order point requirements are deleted and requirements are
generated from outstanding customer order and job orders.

When Order policy is changed from Requirement or None to Order Point, all
planned orders are deleted and requirements not linked to a purchase order or job
order are deleted. Pegged requirements remain and are processed until the demand
is satisfied. Regardless of outstanding requirements, inventory is evaluated to
determine if has fallen below the order point quantity defined and an order point
requirement is generated as needed.
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Deleting Scheduling Data for an Item

To delete scheduling data for an item (including all requirements and planned orders for the
item), perform the following steps:

1. Display the bill of materials you wish to delete. See “Displaying Scheduling Data
for an Item” above.

2. Click the Delete button X located on the toolbar.

3. Click the “Yes” button on the “Confirm Action” pop up message. If you do not
want to delete the scheduling data, click “No” on the “Confirm Action” pop up
message.

Note: Once scheduling data is deleted, it can no longer be displayed or updated.

Displaying Scheduling Data for the Previous Item

To display scheduling data for the item that precedes the item currently displayed, perform
the following steps:

1. Click the Previous button * located on the toolbar.
2. The scheduling data for the previous item is displayed on the main screen.
Displaying Scheduling Data for the Next Item

To display scheduling data for the item that follows the item currently displayed, perform
the following steps:

1. Click the Next button ! located on the toolbar.
2. The scheduling data for the next item is displayed on the main screen.

Tip: You can use the Next button " as a convenient way to locate the first record
in the database. Start by erasing the screen using the Erase button .é, then
click the Next button V.
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Requirements

What is a Requirement?

A requirement represents demand for an item. Requirements can come from customer
orders or job orders or they can be entered manually. Also, material scheduling will
generate a requirement for Safety Stock if current supply cannot satisfy the safety stock
quantity defined for the item on the Item Data screen. Safety stock is the quantity you want
to have on hand at all times to prevent shortages and outages.

The release date and due date on a requirement may be adjusted if the date is in the
Material Scheduling calendar as a Holiday, Vacation, Day Off, or Weekend. Release dates
are adjust back a day at a time until valid date is found and due dates are adjusted
forwards a day at a time until a valid date is found (a valid date is a date that is not in the
Material Scheduling calendar). For more information about calendars, see the Shared
Applications Users Guide.

The requirements screens allow you to view and process requirements.
Requirements Screens

“Requirements” consists of two tabbed screens that are used to view and maintain
requirement data.

Requirements
This screen allows you to view the requirements (demand) for a particular item.

Summary

This screen allows you to view requirements for multiple items based on the selection
criteria used.
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Requirements Screen

Use this screen to display all of the outstanding requirements for an item.

Item Data

Field

Item/Part

Type

Description

Status

Total Onhand

Item Level

Safety Stock

Explanation

A unique identifier assigned to each item. It is the main
key for all other item data. The identifier can be a
number, a name, or some combination of numbers and
characters.

The type helps further define an item by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide,
"Tool" for something you use in your operation.

Contains information describing the item. This
description can be as short as an abbreviation or a long
detailed description of the item.

Current status of the item (Active or Inactive)

The total quantity of this item currently on hand in all
inventory locations.

The lowest level at which this item appears on any Bill of
Materials.

The quantity of stock that should be considered before
all other requirements. Safety Stock is defined for the
item on the Item Data screen under Item Schedule
Data.

Requirements Table (Requirements, Orders, and Description tabs)

Column
Row
Due Date

Release Date

Type

Quantity

Priority

Explanation

The line number of the row in the table.
Date by which this requirement must be fulfilled.

Date by which a planned order for this item must be
released in order for it to be fulfilled by the due date.

Type of requirement — Independent is a top level item
not needed by another assembly; Dependent is a
component of a higher level item.

Quantity required.

Relative priority of this requirement (1 is highest 9 is
lowest)
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Source

Status

Customer Order #

Customer Line #

Job Order #

Description

Parent ltem

Message Line

Field

Message

Indicates where the requirement came from, e.g.
Customer Order, Order Point, Manual (manually inserted
using this screen)

Current status of this requirement, either Active or
Inactive.

The customer order number represented by this
requirement.

The line number on the customer order number
represented by this requirement.

The job order built specifically for this requirement.

Information explaining why or how this requirement was
created.

The item that caused this dependent requirement to be

generated. The parent item is the item directly above
this item in a bill of materials.

Explanation

Displays information about the current status of the
screen including error messages.

Accessing the Requirements Screen

1. Click the plus (“+”) next to “Material Scheduling” or double-click Q “Material
Scheduling” in the “NavTree”.

_o r_

Click on the “View” menu. Select “Goto Screen”, then select “Material

Scheduling”.

2. Click “Requirements”. The “Requirements” screen is displayed.

3. If there is an item or part number in the “ltem/Part” field, the requirements for
that item are displayed on the main screen.
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Using the Requirements Screen

Use these procedures to erase the screen, display requirements for an item, add
requirements for an item, update requirements for an item, delete requirements for an
item, display the requirements for the previous item, and display the requirements for the

next item.

Erasing the Screen

To erase the data from the screen click the Erase button & located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying Requirements for an Item

To display requirements for an item, perform the following steps:

1.

2.

3.

Enter an item or part number in the “lItem/Part” field.

Click the Open (Display) button & located on the toolbar or hit the Enter key.
The requirements are displayed on the main screen.

-or-

Use the Search button # next to the “Item/Part” field, the “Description” field, the
“Type” field, or the “Status” field to select an item number.

Double-click on the “Item/Part” you would like to display in the “Search” screen
table.

The requirements are displayed on the main screen.

Adding Requirements for an Item

To add requirements for an item, perform the following steps:

1.

Enter or select the item for which you wish to add a requirement. See
“Displaying Requirements for an Item” above.

In an empty row, enter or select a Due Date or a Release Date or both dates. If a

date is not entered it will default to current date and may be adjusted later by
material scheduling. If there are no lines displayed you may have to use the add

rows button E' in the lower right corner of the table.
Enter the quantity needed for the new requirement.
Enter a description for the requirement if desired. This is optional.

Repeat steps 2 through 4 for each requirement you wish to add.

When done, click the Save button EI located on the toolbar.
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Updating Requirements for an Item
To update requirements for an item, perform the following steps:

1. Display the item you wish to change. See “Displaying Requirements for an Item”
above.

2. Change data as desired.

4. When done, click the Save button & located on the toolbar.
Updating Requirements for an Item
To update requirements for an item, perform the following steps:

1. Display the item you wish to change. See “Displaying Requirements for an Item”
above.

2. In the Requirements table, change the Quantity and/or the Description for each
requirement you want to update.

3. When done, click the Save button ld 10cated on the toolbar.
Note: Only manually entered requirements can be updated.
Deleting Requirements for an Item
To delete requirements for an item, perform the following steps:

1. Display the item you wish to change. See “Displaying Requirements for an Item
above.

2. In the Requirements table, click the checkbox " in the “Delete” column on the
requirement row you wish to delete.

3. When done, click the Save button = located on the toolbar.

Note: Some requirements may be added back by the material scheduling process.
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Displaying Requirements for the Previous Item

To display requirements for the item that precedes the item currently displayed, perform
the following steps:

1. Click the Previous button 4 located on the toolbar.
2. The requirements for the previous item are displayed on the main screen.
Displaying the Requirements for the Next Item

To display the requirements for the item that follows the item currently displayed, perform
the following steps:

1. Click the Next button * located on the toolbar.
2. The requirements for next item are displayed on the main screen.

Tip: You can use the Next button ¥ as a convenient way to locate the first record
in the database. Start by erasing the screen using the Erase button .Gf, then
click the Next button ! .
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Requirements Summary Screen

Use this screen to view the requirements currently outstanding for items based on the
selection criteria used.

Selection Criteria Group

Field Explanation
Item/Part Enter a full or partial item to search requirements by

item number. Use the percent sign (%) for wildcards.

Type Select a requirement type to limit the summary to only
the requirement type selected or leave this field blank
for all requirement types.

Source Select a requirement source to limit the summary to
only the requirement source selected or leave this field
blank for all requirement sources.

Status Select a requirement status to limit the summary to only
the requirement status selected or leave this field blank
for all requirement statuses.

Number of Rows to Display Controls the number of requirements to retrieve and
display.

Summary Table (Requirements, Description, Order, and Parent Item tabs)

Column Explanation

Row The line number of the row in the table.

Item/Part The item the requirement is for.

Release Date Date by which a planned order for this item must be

released in order for it to be fulfilled by the due date.
Due Date The date by which this requirement must be fulfilled.
Type Type of requirement — Independent is a top level item

not needed by another assembly; Dependent is a
component of a higher level item.

Quantity Quantity required.

Priority Relative priority of this requirement (1 is highest 9 is
lowest)

Item Description Description of the item the requirement is for.

Requirement Description Information explaining why or how this requirement was
created.

43



Customer Order #

Customer Line #

Purchase Order #

Purchase Line #

Job Order #

Source

Status

Parent Item

Message Line

The customer order number represented by this
requirement.

The line number on the customer order number
represented by this requirement.

The purchase order built specifically for this
requirement.

The line number on the purchase order built for this
requirement.

The job order built specifically for this requirement.
Indicates where the requirement came from, e.g.
Customer Order, Order Point, Manual (manually inserted

using the Requirements screen)

Current status of this requirement, either Active or
Inactive.

The item that caused this dependent requirement to be

generated. The parent item is the item directly above
this item in a bill of materials.

Explanation

Displays information about the current status of the
screen.
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Accessing the Requirements Summary Screen

1. Click the plus (“+) next to “Material Scheduling” or double-click Q “Material
Scheduling” in the “NavTree”.

_O r_

Click on the “View” menu. Select “Goto Screen”, then select “Material
Scheduling”.

2. Click “Requirements”. The “Requirements” screen is displayed.

3. If there is an item or part number in the “ltem/Part” field, the requirements for
that item are displayed on the main screen.

4. Click the “Summary” tab at the top of the main screen.
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Using the Requirements Summary Screen

Use these procedures to erase the screen and display item requirements.

Erasing the Screen

To erase the data from the screen click the Erase button -é located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying Requirements Using Selection Criteria
To view requirements using selection criteria, perform the following steps:

1. Enter all or part of an item number in the “Item/Part” field, or use the Search
button @ next to the “Item/Part” field to select an item number.

2. Enter or select any of the other optional selection fields or leave them blank so
the summary is not limited by those selections.

3. Click the Open (Display) button & located on the toolbar.
4. View the Requirements Summary displayed on the screen.
5. If the record you are looking for is not displayed in the table, either increase the
“Number of Rows to Display” or change the selection criteria.
Displaying Planned Orders for All Items
To display planned orders for all items, perform the following steps:
1. Click the Erase button -# located on the toolbar
2. Click the Open (Display) button & located on the toolbar or hit the Enter key.
3. The requirements for all items are displayed on the main screen. If you do not

see the item you are looking for you may have to adjust the value in the
“Number of Rows to Display” field at the top of the screen.
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Planned Orders

What is a Planned Order?

Material scheduling processes all of the demand for an item against all of the supply for an
item. When demand exceeds supply a planned order is generated for the item with the date
and quantity needed.

The planned order screens allow you to view and process the planned orders generated by
material scheduling.

Planned Order Screens

“Planned Orders” consists of two tabbed screens that are used to view and maintain planned
order data.

Planned Orders

This screen allows you to view the planned orders generated by material scheduling for a
particular item. It also allows you to turn a planned order into a job order or a purchase
order.

Summary

This screen allows you to view the planned orders generated by material scheduling for
multiple items based on the selection criteria used.
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Planned Order Screens Explained

Planned Orders Screen

This screen allows you to view and delete planned orders for an individual item. It also
provides a way to build job orders and purchase orders from the planned orders.

Item Data

Field Explanation

Item/Part A unique identifier assigned to each item/part. It is the
main key for all other item/part data.

Type The type helps further define a line by giving it a
classification. Some examples of types are: "Assembly"
something you build, "Service" for a service you provide.

Description Contains information describing the item/part.
Status Specifies whether the item/part is active or inactive.

Order Policy The order policy determines how requirements will be
generated and how material scheduling will build
planned orders for an item:

None Requirements are generated from
customer orders but no planned orders
are generated

Order Point A requirement is generated when
inventory falls below the Order Point
Quantity defined. Planned orders are
generated using the Fixed Order Quantity
defined for the item

Requirement Requirements are generated from
customer orders and job orders. Planned
orders are generated based on
requirements -- for each unit required one
will be planned, i.e. planned order
quantities match requirement quantities

Item Level Indicates the lowest level on which this item appears on
all bills of materials.

Sourcing Indicates how the item is normally acquired:

Purchase The item is purchased
Manufacture The item is manufactured

On Hand Total quantity in inventory for this item.

48



Planned Orders Table (Planned Orders and Order Links Tabs)

Field

Release Date

Due Date

Status

Source

Quantity

Delete

Customer Order #

Customer Line #

Job Order #

Message Line

Explanation

Date by which the planned order must be released for
the item to be in inventory by the due date.

Date by which the planned order must be fulfilled to
satisfy the demand for which it was generated.

Current status of this planned order e.g. Active

Indicates where the original requirement came from,
e.g. Customer Order, Order Point, Manual (manually
added using the Requirements screen)

The quantity required based on the requirement for
which this planned order was generated. It may be less
than the original requirement if part of the requirement
quantity could be satisfied by other supply.

Check this box then click Save button = located on the
toolbar to delete this planned order.

The customer order number associated with the
requirement for which this planned order was generated.

The line number of the customer order number
associated with the requirement for which this planned
order was generated.

The job order number associated with the requirement
for which this planned order was generated.

Explanation

Displays information about the current status of the
screen including error messages.
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Accessing the Planned Orders Screen

1. Click the plus (“+) next to “Material Scheduling” or double-click Q “Material
Scheduling” in the “NavTree”.

_O r_

Click on the “View” menu. Select “Goto Screen”, then select “Material
Scheduling”.

2. Click “Planned Orders”. The “Planned Orders” screen is displayed.

3. If there is an item or part number in the “ltem/Part” field, the planned orders for
that item are displayed on the main screen.
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Using the Planned Orders Screen

Use these procedures to erase the screen, display, delete, build job orders, build purchase
orders, display the previous, and display the next item’s planned orders.

Erasing the Screen
To erase the data from the screen click the Erase button & located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying an Item’s Planned Orders
To display an item’s planned orders, perform the following steps:
1. Enter an item/part number in the “ltem/Part” field.
2. Click the Open (Display) button & located on the toolbar or hit the Enter key.
3. The item/part planned orders are displayed on the main screen.
—or-
1. Use the Search button # next to the “Item/Part” field, the “Type” field, the
“Description” field, or the “Status” field to select an item/part number from a list

of items regardless of whether or not they have planned orders.

2. Double-click on the “lItem/Part” you would like to display in the “Search” screen
table.

3. The item/part planned orders are displayed on the main screen.
Deleting a Planned Order
To delete a planned order, perform the following steps:

1. Display the item planned order you wish to delete. See “Displaying an Item’s
Planned Orders” above.

2. Click the Check box I in the delete column of the planned order you want to
delete. You may select more then one planned order to be deleted at one time.
Click the checkbox . again to remove the deletion flag.

3. Once finished, click the Save button H located on the toolbar.

Note: Planned orders may be generated again by material scheduling.
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Building a Job Order

To build job orders from selected planned orders for this item, perform the following steps:

1.

7.

Click the Build Job Order button ‘5‘:& located on the toolbar. A pop-up screen will
appear.

Enter or select the criteria you want to use for displaying planned orders.
Click the Open (Display) button & located at the top of the pop-up screen.
Planned orders based on the selection criteria used are displayed.

Check the box in the column “Build” for each planned order you want.

Enter a job order number and job order type or leave these columns blank for the
next job order number available and job order type “Production”

Click the Build button 65& located at the top of the pop-up screen

A new job order will be built for each planned order selected. Job orders can be located and
viewed with the Job Order screen under Job Order Management.

Note: This feature is available only if TFG4000 Job Order Management is installed.

Building a Purchase Order

To build a purchase order from selected planned orders, perform the following steps:

1.

2.

Click the Build Purchase Order button ﬁﬁ#’ located on the toolbar.

Enter or select the criteria you want to use for displaying planned orders.
Click the Open (Display) button & located at the top of the pop-up screen.
Planned orders based on the selection criteria used are displayed.

Enter or select the Supplier you want to use for the purchase order.

Enter a purchase order number or leave it blank and the system will generate
one for you.

Select a purchase order type or leave this field blank and it will default to
“Purchase Order”

Enter Release Date and Due Date.

Check the box in the column “Build” for each planned order you want.

Note: If an item has a sole source supplier, the “Sole Source” column will be
checked and the supplier chosen for the purchase order must match the
supplier for the item. If they do not match you must uncheck “Build” for

that line, uncheck “Sole Source” for that line, or change the supplier for
the purchase order.
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10. Click the Build button FE;E located at the top of the pop-up screen
A new purchase order will be built with a purchase order line for each planned order
selected. Purchase orders can be located and viewed with the Purchase Order screen under
Purchasing Management.
Note: This feature is available only if TFG4000 Purchasing Management is installed.

Displaying the Previous Item

To display planned orders for the item that precedes the one currently displayed, perform
the following steps:

1. Click the Previous button ¥ located on the toolbar.

2. The planned orders for previous item are displayed on the main screen.
Displaying the Next lItem

To display planned orders for the item that follows the one currently displayed, perform the
following steps:

1. Click the Next button P located on the toolbar.
2. The planned orders for the next item are displayed on the main screen.

Tip: You can use the Next button as a convenient way to locate the first record in
the database. Start by erasing the screen using the Erase button #or
blanking out the “Item/Part” field, then click the Next button * .
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Planned Order Summary Screen

Use this screen to view planned orders for items based on the selection criteria used.

Selection Criteria Group

Field

Item/Part

Type

Source

Status

Number of Rows to Display

Summary Table (Plan Orders and
Column

Row

Item/Part

Release Date

Due Date

Status

Quantity Released

Item Description

Explanation

Enter a full or partial item to search planned orders by
item number. Use the percent sign (%) for wildcards.

Select a planned order type to limit the summary to only
the planned order type selected or leave this field blank
for all planned order types.

Select a requirement source to limit the summary to
planned orders generated for only the requirement
source selected or leave this field blank for all
requirement sources.

Select a requirement status to limit the summary to only
the planned order status selected or leave this field
blank for all planned order statuses.

Controls the number of planned orders to retrieve and
display.

Description tabs)

Explanation

The line number of the row in the table.
The item the planned order is for.

Date by which this planned order must be released for it
to be completed by the due date.

The date by which this planned order must be fulfilled to
satisfy the requirement for which it was generated.

Current status of this planned order, e.g. Open

The quantity required based on the requirement for
which this planned order was generated. It may be less
than the original requirement if part of the requirement
quantity could be satisfied by other supply.

Description of the item the planned order is for.
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Message Line

Field Explanation
Message Displays information about the current status of the
screen.

Accessing the Planned Order Summary Screen

1. Click the plus (“+) next to “Material Scheduling” or double-click Q “Material
Scheduling” in the “NavTree”.

_O r_

Click on the “View” menu. Select “Goto Screen”, then select “Material
Scheduling”.

2. Click “Planned Orders”. The “Planned Orders” screen is displayed.

3. If there is an item or part number in the “ltem/Part” field, the planned orders for
that item are displayed on the main screen.

4. Click the “Summary” tab at the top of the main screen.
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Using the Planned Order Summary Screen

Use these procedures to erase the screen and display planned orders.

Erasing the Screen

To erase the data from the screen click the Erase button -¢ located on the toolbar.

Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the
screen in preparation for another operation.

Displaying Planned Orders Using Selection Criteria
To view planned orders using selection criteria, perform the following steps:

1. Enter all or part of an item number in the “Item/Part” field, or use the Search
button @ next to the “Item/Part” field to select an item number.

2. Enter or select any of the other optional selection fields or leave them blank so
the summary is not limited by those selections.

3. Click the Open (Display) button & located on the toolbar.
4. View the Planned Orders Summary displayed on the screen.
5. If the record you are looking for is not displayed in the table, either increase the
“Number of Rows to Display” or change the selection criteria.
Displaying Planned Orders for All Items
To display planned orders for all items, perform the following steps:
1. Click the Erase button -# located on the toolbar
2. Click the Open (Display) button & located on the toolbar or hit the Enter key.
3. The planned orders for all items are displayed on the main screen. If you do not

see the item you are looking for you may have to adjust the value in the
“Number of Rows to Display” field at the top of the screen.
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Trigger Log

When item scheduling data is updated and when activity occurs that affects demand
(customer orders and job orders) or supply (inventory transactions, purchase orders, and
job orders), a record is written so material scheduling will know and item must be re-
planned. The record is called a “trigger” because it triggers the material scheduling process.

The Trigger Log screen allows you to display and maintain trigger records written from
various places within the TFG4000 applications. Some triggers have not been processed yet,
some may have errors that may be corrected and the trigger can be re-processed, and
some may have errors that prevent processing.
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Trigger Log Screen

Items in need of material scheduling are added to a list (log) where they can be processed.
This screen displays items that have not been processed yet, items that had errors, and it
allows you to re-process and delete items from the log.

Selection Criteria Group

Field Explanation
Type Use this field to select the type of triggers you want to view or

leave it blank for all trigger types.

Status Use this field to display triggers based on trigger status or leave
this field blank to view all triggers regardless of status.

Number of Rows

to Display Controls the number of log records to retrieve.

Trigger Table (Trigger, Error, and Description tabs)

Column Explanation

Row The line number of the row in the table.

Level The lowest level at which this item appears on any bill of
materials

Priority Relative priority of this item for materials scheduling process (1

is highest and 9 is lowest)
Item Item in need of material scheduling.

Type Type of item this is relative to the planning needed
(Independent or Dependent)

Status Current status of the log record.

RP Reprocess check box. A check in this box indicates this item
must be re-processed during the next material scheduling
cycle.

Error Type If an error was encountered while trying to process this item,

this column will indicate the type of error it was.
Error Description Description of the error encountered if applicable.

Description Additional information describing why the item is in need of
material schedule processing.

Delete This is a checkbox to indicate you want to delete an item from
the log.

Message Line

Message Displays information about the current status of the screen.
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Accessing the Trigger Log Screen

1. Click the plus (“+”) next to “Material Scheduling” or double-click Q “Material
Scheduling” in the “NavTree”.

_o r_

Click on the “View” menu. Select “Goto Screen”, then select “Material
Scheduling”.

2. Click “Item Schedule Data”. The “lItem Schedule Data” screen is displayed.

3. If there is an item or part number in the “lItem/Part” field, the scheduling data for
that item or part number is displayed on the main screen.

4. Click the “Trigger Log” tab at the top of the main screen.
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Using the Trigger Log Screen

Triggers are written to start material scheduling automatically; then they are processed at
intervals defined by System Variables. The variable Material_Scheduling must be set to
“Yes” to allow material schedule processing to be run. Variable
TFGMaterialScheduleTrigger indicates the number of minutes the system will wait
between processing. It should be set to a number greater than O for processing to begin.
If an error is encountered during trigger processing the trigger is updated to indicate an
error was found and a description of the error is added to the trigger. Some errors can be
corrected so the trigger can be processed successfully while other errors are so severe the
trigger cannot be processed.

If an error was encountered and the error was corrected, individual triggers can be flagged
for reprocessing or all triggers can be reprocessed. If the error could not be corrected you
may want to delete the trigger until the error can be corrected.

Use these procedures to display pending triggers, reprocess individual triggers, reprocess all
triggers, and delete triggers.

Displaying Triggers
Perform the following steps to display triggers:

1. Enter or select any of the selection criteria fields as desired.

2. Click the Open (Display) button H located on the toolbar.
Reprocessing Individual Triggers
Perform the following steps to reprocess triggers individually:

1. Click the RP (Reprocess) checkbox [ for each trigger you want to reprocess. You
may select more then one trigger to be reprocessed at one time. Click the
checkbox again to remove the reprocess flag.

2. Repeat step 1 as necessary for each additional trigger you wish to update.

3. Once finished, click the Save button [ 1ocated on the toolbar.

Reprocessing All Triggers
Perform the following steps to reprocess all triggers displayed:

1. Display the triggers you want to reprocess (see Displaying Triggers above).

2. Click the Reprocess button %3 located on the toolbar.
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Deleting Triggers
To delete unit of measure conversions, do the following:

1. Click the Delete checkbox [ for each trigger you want to delete. You may select

more then one value to be deleted at one time. Click the checkbox again to
remove the deletion flag.

2. Once finished, click the Save button E located on the toolbar.
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Advanced Installation

TFG4000 Professional Edition provides some advanced installation functionality such as: font
sizes, system variables, server start up options, BAT file options for single user and multi
user modes.

Please refer to the System Administration User Guide for more information.

Documentation

TFG4000 documentation (in PDF format) is available online at www.tfg4000.com, through
the “Documentation” menu on each screen, and from the Windows “Start” menu. Simply
click “Start”, then “Programs”, then “TFG4000 Professional V1.4", and then
“Documentation”.

Note: PDF files require Adobe® Acrobat® Reader. The reader is available at
www.adobe.com free of charge.

Registration

Quick & Easy Online: After installation, you can go to our web page at www.tfg4000.com
to register the product. Click on “Register” and follow the instructions.

Suggestions

We are eager to improve TFG4000 Professional Edition, and we urge you to tell us what you
think of the software and how it could be improved to better suit your needs. We have
taken many suggestions from our customers and incorporated them into our products. If
you have suggestions or comments, please send an e-mail to tfg4000@fredrickgroup.com.
We want to hear from you!

Services

The Fredrick Group, Inc. offers assistance in data conversion. For more information, contact
The Fredrick Group, Inc. directly by either:

E-mail Send an e-mail to tfg4000@fredrickgroup.com, with ‘Services’ in the subject line.

Phone Call 770-844-8516 between 9:00 AM - 5:00 pm Eastern Time Monday through
Friday (except holidays)
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Support

Note: You must be registered in order to receive support.

Initial Installation Support

The Fredrick Group, Inc. provides free initial installation support via e-mail. Installation
support is available for 30 days, and is activated when you send your first message. You
may also receive installation support by calling, but you must pay the cost of the call.
Technicians are available on a limited basis Monday through Friday (except holidays) from
9:00 am to 5:00 pm Eastern time. The TFG4000 Professional Edition product technical
support number is 770-844-8516.

Pay-As-You-Go Support

Additional fee-based support is available. You pay the cost of the call plus an additional fee.
Credit card information must be provided and confirmed before a call is accepted.
Technicians are available on a limited basis Monday through Friday (except holidays) from
9:00 am to 5:00 pm Eastern time. The TFG4000 Professional Edition product technical
support number is 770-844-8516.

Contact The Fredrick Group, Inc. at tfg4000@fredrickgroup.com for more details.

Other Support Options
Other support options are available.

Contact The Fredrick Group, Inc. at tfg4000@fredrickgroup.com for more details.

Note: Support plans and fees are subject to change without notice.

For more information go to www.tfg4000.com.
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